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1. Safety Instructions 

 

 Observe the respective documentation of the robot kinematics, in particular the 
safety instructions contained therein. 
 

 Backup important data before installing the CPRog software. 
 

 Before updating the CPRog software, create a backup of the current version, e.g. by 
renaming the folder C:\CPRog\ to C:\CPRogBAK\. 
 

 Always ensure personal safety when operating a robot arm or commissioning a 
robot cell! Ensure that there are no persons within reach of the arm or other danger 
points! 
 

 CE marking:  
Robot arm and control system are only one part of a system that must be evaluated 
for risks in its entirety and comply with the current safety regulations. The 
commissioning engineer of the plant is responsible for this.  
The EC declaration of conformity of the robot controllers / kinematics can be found 
in the corresponding documentation. 
 
 
 

. 



6 
 

2. Introduction 

CPRog is a control and programming environment for robots. The 3D user interface allows a 
quick start into programming.  Due to the modular design different kinematics and motor 
drivers can be controlled. 

 

These operating instructions are supplemented by the respective robot-specific operating 
instructions. 

2.1 Specification 

Operating System Microsoft Windows 10 
Minimum system 
requirements 

Processor: similar to Core i3 or better 
Hard disk space: 200 MB 
 1 USB 2.0 port 
 1 Ethernet port 
.NET Framework 4.5  

Supported motor 
electronics interfaces  

CPR protocol CAN-V2 
CANopen for selected motor controller 
Lynxmotion SSC-32u 

Supported CAN adapters PEAK-System PCAN-USB 
Kinematics Articulated arm robot with 4, 5 or 6 axes 

Gantry robot with 3 axes 
Delta robots 
Each with up to 3 additional axes 
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3. Installation 

 

Insert the CPRog CD or the USB 
stick into the drive. Depending on 
your system the CD menu will open, 
or please start manually: 
D:\autorun\autorun.exe 
or 
D:\CPRogInstaller.exe 
 
You may have to allow changes on 
your system.  
After starting the installation you 
have to choose between German 
and English as language. Then 
confirm the license agreement. 

 

In the next step you can choose 
where CPRog should be installed. 
The recommended directory is  
C:\CPRog. 
 
When installing CPRog in a Windows 
program directory like 
C:\Programs  
it is possible that CPRog can only be 
started as administrator. 

 

The installation usually only takes a 
few seconds. 
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After finishing the installation you 
can start CPRog directly. 

 
Now you can start CPRog via the link on the desktop or via the start menu.  
After the start you can select the suitable project with your robot in the logo menu above left. 

Installation error:  The installation wizard checks whether all necessary extensions are 
available, especially the .NET framework. If this is not the case, an error message appears. 
The .NET framework must be installed manually: 

 Search the network for "Microsoft .NET download" and install it. 
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3.1 Installing the CAN-to-USB Driver 

The robot is delivered with the PCAN-USB driver from www.peak-system.com. To use the 
adapter, the appropriate driver must be installed. This can be done from the CPRog 
installation CD (button "Install USB-CAN Adapter"), from the USB stick (directory PCAN-
USB-Adapter) or from the installation CD of the manufacturer. 

After starting the installation, you must  

 accept the license agreement and  
 specify the installation folder. 

In the next step, please check whether the PCAN-USB device and the PCAN-View CAN-Bus 
Monitor are selected for installation as shown in the following figure. 

 

Choose for the installation: 
 PCAN-USB 
 PCAN-View 

 
The PCAN-View Monitor 
offers the possibility to check 
whether the adapter is 
correctly connected. 

 
 
 

3.2 Licensing 

The CPRog software requires a license key to be started.  
This key is already integrated in the installation version of CPRog.  

Please do not change the content of the license file, otherwise it will become invalid! 

The included standard license allows the installation and use of CPRog on any number of 
computers in the company or organization of the licensee. 
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4. The CPRog Programming Environment 

Section 4 explains the CPRog software, all steps can be simulated. In section 5 the real robot 
is then connected and moved. 

4.1 Introductory Remarks 

The CPRog programming environment allows control and programming of the robolink 
robot arm. You can work both online and offline, i.e. without robots. CPRog is a Windows 
software. 
 

 
Figure 2: CPRog user interface 

 
In the upper area, the two tabs "Scene" and "Motion" provide access to the main 
functionalities. In the left corner, information about the current state of the physical robot is 
displayed. 
There are five tabs at the bottom: 

 "Log Message": Messages from the program about status or errors. 
 "Info Center": Shows axis values, the cartesian position and further information. 
 "Jog": Keys to move the robot 
 "DIN-Rail Input/Output": Display and set the digital IO of the control unit. 
 "Variables: Displays the current state of program variables. 



11 
 

Additional functions such as loading another project or referencing the robot can be found in 
the menu that opens when you click on the round logo in the upper left corner.  

4.2 Selecting the right Robot Type 

CPRog offers project-related settings for different types of robots, such as 4- or 5-axis 
robots. Please download the project that fits your robot arm. An example: 

 igus_5DOF_SV_AE.prj 
 5DOF stands for a 5-axis robot (DOF = Degrees of Freedom). 
 SV stands for "Small Version", BV for "Big Version". 
 AE stands for "output encoder. The projects for robots with motor encoders do not have 

this abbreviation. 

Click on the circle in the upper left corner and select "Open project". Now select the file with 
your robot arm. CPRog remembers your setting. 

  
 
Figure 3: "Open Project" menu entry 

4.3 Navigation with the Mouse 

To navigate in the CPRog 3D environment, a 3-button mouse is recommended: 

 Left button: Selection of robot and other objects 
 Middle button: Navigation in the scene 

o Turn it: Drag the mouse while holding down the middle mouse button. 
o Move: Drag the mouse while holding down the middle mouse button and holding 

down the CTRL key. 
o Zoom: Drag the mouse with the middle mouse button pressed and hold down the 

SHIFT key (zooms to the centre of the scene). 
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 Mouse wheel: Zoom to the current cursor position 
 Right key: Opens the context menu. 

Alternatively, the function of the left mouse button can be changed in the upper menu area 
under Scene/Navigation. Possible options are selection, rotation, panning or zooming. 

4.4 Move the Robot with Joypad and Buttons 

The robot can be moved (or "jogged") manually while no program is running. The main controls 
are the Joypad Connect Panel, the Motion Type Selection List, and the Override. 

  
Figure 4: Control panels for moving the robot  

 
By pressing the joystick button, CPRog connects to a joypad.  If the connection was 
successful, a green OK sign is displayed on the joystick button.  

The device must be of the "Joystick" or "Gamepad" type. You can find further information on 
establishing a connection in the protocol window. 

The "Joint" mode allows the individual robot axes to be moved from A1 to A6, if available. In 
Cart Base mode, the robot moves in straight lines along the X, Y and Z axes of the base 
coordinate system. In Cart Tool mode, the robot moves according to the current tool 
coordinate system. 

The override scales the movement speed between 0 and 100%. 

 
Figure 5: The buttons for joint movements. In the card safe mode, the keys change to X, Y, Z, A, B, C. 
 
 

When the Virtual Wall is active, the program prevents it from leaving the 
allowed area. 
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The easiest way to move the robot is with a connected joypad. The picture below shows 
the key assignments. 

 

 
 
Legend: 
1. Change Movement Mode 
2. Change active robot 
3. Gripper open/close 
4. Record motion point 
5. Change key assignments: 

Switching between  
X, Y, Z and A, B, C 

 
Figure 6: Key assignments of the joypad. Upper lines for Cartesian mode, lower for Joint mode. 

 

 

4.5 Interactive Motions of the Robot in the UI 

An alternative to the joypad is to drag the robot in the graphical 3D environment. When 
selecting an axis and moving the mouse with the left mouse button pressed down, this axis 
rotates forwards or backwards depending on the mouse movement. The mouse has to be 
dragged up and down. 

4.6 Create Robot Programs 

CPRog allows the creation of robot programs that are saved as . xml files. The integrated 
program editor is provided for editing these files, but small changes can also be made with a 
standard text editor. 

4.6.1 Edit program 

The "TextEdit" button in the "Edit programs" area of the "Motion" tab opens the TextEdit 
program editor.  
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Figure 7: TextEdit Program Editor 
 
The five buttons on the right allow direct operation: 

 Recording of a motion command (linear or joint, depending on the current 
motion type of the robot) with the current robot position 

 Recording a pause 
 Recording of a gripper command 
 Delete the selected line 
 Set the selected line as the starting point for the next program start. 

All fields of the commands can be edited directly, e.g. change the speed. Changes are applied 
when another line or field is clicked.  

Press the "Delete" key to delete the current line. To remove text from a cell, use the 
"Backspace" key. 

A line can be copied with Ctrl-C (or in the Edit menu), Ctrl-V inserts the command again. 

All new commands are inserted in the line above the selected line. 

If "Save" is selected from the File menu, the current program is saved and loaded into the 
robot. Thereby the robot is synchronized with the text editor again. 

If you select "Save as" from the File menu, the current program will be saved under a different 
name. The new file is loaded into the robot. 
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The editor contains a syntax check. Invalid cells are highlighted red, the syntax of the 
command is displayed in the bottom line as help. While the program contains syntax errors, it 
cannot be saved. 

4.6.2 Command specification 

The following table shows a list of commands. The document "CPR_Command Reference.pdf" 
contains detailed command specifications and examples and can be found on the Wiki, in the 
section "Programming Environment CPRog". 

Command Function  
Motion  
Joint Movement in Joint Mode 
JointByVariable As above, but the objective is defined by a variable. 
Linear Movement on a straight line to a cartesian xyzabc position  
LinearByVariable As above, but the target position is defined by a variable. 
RelativeBase Relative motion with offset in base coordinates 
RelativeTool Relative motion with offset in tool coordinates 
RelativeJoint Relative motion with offset in joint coordinates 
All: Abort Condition  Motion commands can be interrupted 
All: Smoothing Smooth transition between movements 
All: Acceleration Acceleration for movements 
Input / Output   
DigitalOut Setting a digital output to On or Off 
Gripper Opening or closing the gripper (depending on configuration) 
Structure   
LoopCounting Loop with a number of passes  
LoopConditional Loop with termination condition 
If-Then-Else Conditional branching 
Wait Wait until a period has elapsed 
WaitConditional Wait until a condition is fulfilled 
Sub Calling a subroutine  
Advanced  
DefPosVariable Definition of a Position Variable 
DefNumberVariable Definition of a Number Variable 
Variable Operations Operations like plus or minus on variables 
PluginTargetPos Calls a plugin to e.g. get a target position from a camera 
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4.7 Start Robot Programs 

The robot program must be loaded and started. 

1. Load the program: 
Press the folder icon in the "Edit Program"  
area of the "Motion" tab and select a program, e.g. igus5DOF_TestMotion. Xml 
 

 
 

2. Adjust the override: 
Before starting a new program, set the override to e.g. 20%. Be particularly 
attentive during the first complete program run. 

3. Start the program: 
Press the playback icon in the Run Program area of the Motion tab. 

4. Stop or pause the program: 
After pressing the pause symbol, the robot continues with the program by pressing 
the playback symbol again. 
After pressing the stop symbol, the program starts with the first command when 
the playback is pressed again. 
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5. Connecting the Real Robot 

5.1 Connection to Hardware 

The real robot can be controlled like the simulated one, only the hardware has to be 
connected first: Connect", "Reset error" and "Release motors" keys. 

These steps are robot-specific, please observe the operating instructions enclosed with the 
robot kinematics! 

   
Figure 8: Buttons for connecting to the hardware, resetting errors and enabling the motors 

 
Step one:  Establish connection to the hardware. This step initializes the USB 
  CAN interface or the Ethernet connection. 
  The LED on the left side of CPRog changes from grey to red. 
  Several error messages are displayed below the LED. 

Step two: Reset the errors. This key is used to reset the error memories of the 
electronic modules of the controller. The axis positions are transferred 
from the real robot to the simulation environment. The 3D visualization of 
the robot should now correspond to the current position of the real robot.  
 
This must be checked with every error reset!  
If the values do not match, a referencing must be performed, described in 
the following section.  

 
The LED remains red. The error messages are deleted, only "Motors not 
enabled" remains. 
If other error messages are displayed, try again and follow the instructions 
in the robot documentation. 

Step three: Activation of the motors. The LED is now green. 
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5.2 Moving the Robot 

It is now possible to move the robot with the jog buttons, with the mouse in the graphic or with 
a gamepad, see section 4.4. 

5.3 Referencing the Robot 

If the robot is not completely referenced, only joint movements are 
allowed. To avoid collisions, cartesian movements or the start of a robot 
program are deactivated. The reference status is displayed on the left 
side of CPRog. 

The procedure for referencing is described in the robot-specific documentation. 

5.4 Application Configuration 

The configuration of the CPRog software is done via XML files. These can be adjusted with an 
editor. 

5.4.1 Project file 

This file contains project-specific information, such as which robot is to be loaded with which 
start program. Here you can also adjust the number of DIO boards or activate the CRI 
interface. The files are stored in: 

  c:\CPRog\Data\Projects\ 
 

5.4.2 Configuration of the robot 

Each robot in the CPRog software has its own XML file, for example  

C:\CPRog\Data\Robots\igus_5DOF_SV\igus_5DOF_SV.xml 

In this file the software limit switches of the axes can be defined, but also axis speeds or the 
geometry of the arm. 
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5.5 Updating the CPRog Software 

Updates of the CPRog software are available on our Wiki wiki.cpr-robots.com in the section 
"CPRog". Please rename your old CPRog folder to e.g. c:\CPRogBAK before starting the 
installation. So you can switch back to the old version in case of doubt.  

The following has to be transferred from the previous installation: 

 The created robot programs 
 Changes in the project or robot configurations 
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6. Interfaces 

6.1 Digital Inputs and Outputs 

The simplest connection, e.g. to a PLC, is possible via digital inputs and outputs. Each robolink 
controller is supplied with a DIO module. One module provides 7 inputs and 7 outputs. A total 
of 3 modules can be used. 

The outputs are switched by IC relays, capable of up to 500 mA. This value must not be 
exceeded during the switching process (e.g. by charging currents of capacitors). 

6.2 PLC Interface 

The "PLC interface" enables the integration of the robolink arm into a production system 
controlled by a PLC. By means of digital inputs, the PLC can switch the robot ready for 
operation and start a program. It can monitor the status of the robot via digital outputs. In this 
way, the robot can work without manual interaction. Further details are available on  
wiki.cpr-roboter.de, in the section PLC-Interface. 

6.3 Plugin Interface 

CPRog provides a plugin interface. It makes it possible to connect image processing systems 
or PLC components, for example. With various defined functions, the plugins represent a 
bridge between program execution in CPRog and external systems. 
Example: The IFM O2D SmartCamera can recognize taught-in contours and transfer the 
target position via Ethernet. The corresponding plugin reads this position and transfers it to 
the CPRog program flow. The robot can then move to the appropriate position and grip the 
part. 

The plugins can be provided by CPR, or they can be created project specific. Further 
information and C# sample code for a PlugIn can be found at wiki.cpr-roboter.de.  
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6.4 CRI Interface 

The CRI interface enables control of the robot via Ethernet. The robot can be moved, 
programs can be uploaded and executed.  

 

This interface makes it possible to combine the CPRog functions with application-specific 
algorithms, such as a teleoperation system or a database. 

On the wiki.cpr-roboter.de, section "Interfacing" you can download the CRI documentation 
and a C# sample project for a client. 

 

 

7. Support 

You can find further information and instructions on our Wiki: 

 wiki.cpr-robots.com 

Please feel free to contact us directly if you have any problems or questions: 

 Mail: 
 support@cpr-robots.com 

Please describe the problem in detail and send the file "logMessages.log" from the 
folder c:\CPRog\. 

We can support you by mail, phone or TeamViewer and answer your questions! 

 



22 
 

 

 

  



23 
 

  



24 
 

 

 

 

 

 

 

 

 

 

© Commonplace Robotics October 2019 


